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Sorting, Searching, 
Filtering, and Printing 

n this hapter we' lllo kat ways to 
snrl (alphab tize), seard1 f r, repla , 
filter, and print data . Tl1ese opera-

tions are available in both datasheet view and form vi w, althougll you may prefer to 
experiment with them from datasheet v i w wh r lit ffects Me most obvi0us. 

Sorting [Alphabetizing] Your Data 
Sorting data simply means to put it into some meaningful order. For example, we often 
sort lists and address books alphabetically to make it easy to find information. When 
you're working with paper, sorting is a tedious and boring process. But with Access, all 
it takes is a few mouse clicks. 

Quick and Easy Sorting 
Here's how to do a quiCk, simple sort based on any field in your table (except a Hyper
link, Memo or OLE Object field): 

1. Open your table, query, or form in datasheet view or form view (as appropriate). 
2. Click on the field on which you want to base the sort. For example, to put 

employee names into alphabetical order, click on the LastName column selector 
(in datasheet view) or the LastName field (in form view). 



310 CHAPTER 9 • SORTING, SEARCHING, FILTERING, AND PRINTING 

MUdQ;IQM 
The original 

Employees table 
and the sorted 

Employees table 
shown in 

datasheet view. 
We changed 

the sample 
data that 

Access provides. 

3. Do one of the following: 
• To sort records in ascending order (smallest-to-largest or A to Z), click on the 

Sort Ascending toolbar button (shown at left) or choose Records )l- Sort )l- Sort 
Ascending. Or right-click on the column selector (in datasheet view) or the cur
rent field (in form view) and choose Sort Ascending from the shortcut menu. 

• To sort records in descending order (largest-to-smallest or Z to A), click on the 
Sort Descending toolbar button (shown at left) or choose Records )l- Sort )l- Sort 
Descending. Or right-click on the column selector (in datasheet view) or the cur
rent field (in form view), and choose Sort Descending from the shortcut menu. 

In datasheet view, you can easily verify the results by reading down the column that 
you based the sort on (see Figure 9.1). The results of the sort won't be so apparent in 
form view because you can see only one record at a time. But if you scroll through the 
records, you'll see that you're now scrolling though them in a sorted order. (If you're 
viewing a form, you can switch from form view to datasheet view to verify the sort.) 

Last Names in original order 

s·ooris 
6! Lane 
7 JO$eph 
B' Helerr 

(AuloNumber) 
Record: , ·,..-----:-•., 

Last Names in sorted (alphabetical) order 

6 ~ane 

~ rAmi 
3 Emlly 
4 Albert 

7fJose~h 
2 Ahd reV'!_ 
8 Helen 

(AlJ L.olllo,J.mber) 

Lift 
Nlktog 
Nlktog 
~ippl~ 

I
Van Noslo 
Wheels 

• 

Sorts within Sorts 
Sometimes you may need to sort on two or more fields. For example, if a table has many 
names, you might want to sort on the LastName and the FirstName fields. That way, 
surnames will be in alphabetical order, and within each name, they'll be sorted by the 
person's first name as shown in Figure 9.2. 

Sorting on two or more fields is easy: 

1. Open the table or query in datasheet view. Or if you're currently viewing a form in 
form view, switch to datasheet view. 
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Sorting an 

Employees table 
on two fields 

and on a 
single field. 'Anita 

Emily 
Albert 

J ~oseph 
Andrew 
Helen 
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Tille 
Sale s Reptesantal lve 
Qfti~e Manll_QI!r .. 
Sales l~enresen t ative 
Sales Representative 
I S_ales Manager 
Vice President, M rkei!I'IQ 

!Vice Prosrdenl, Sales 
, Produt l Evangel!~ 

Records are sorted by 
LastName only (Niktogs 
are not in alphabetical order 
by FirstName). 

Records are sorted 
by LastName and FirstName. 

• 

2. Move the fields that you want to use to the leftmost column positions (see Chapter 8) 
if necessary. (The fields you're sorting on must be in adjacent columns.) Access will do 
the sort from left to right. Thus to sort by surname and then by first name, arrange the 
columns with the LastName column just to the left of the FirstName column. 

3. Select the column(s) you want to base the sort on . To do so, click on the first col
umn and then Shift-click on additional column(s). In the example below, we 
moved the LastName and FirstName fields to the leftmost column positions and 
then selected those fi elds for sorting: 
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4. Click on the Sort Ascending or Sort Descending toolbar button (depending on the 
order you want) or use the equivalent menu options or shortcut menu options 
given earlier. 

Returning the Records to Their Original Order 
When you 're ready to return the records to their original, unsorted order, choose 
Records~ Remove Filter/Sort. Or right-click anywhere in the datasheet or form and 
choose Remove Filter/Sort. 

Any time you close the table after using the sort feature (described above) or the 
~-..:. filter feature (described later in this chapter), Access will ask if you want to save 

changes to the design of your table. If you choose Yes, Access stores the current 
sort and filter in the table's Filter and Order By properties. 

To learn more about sorting, go to the Access Help Contents, open the Finding And 
Sorting Data book, open the Sorting Data In Tables, Queries, And Forms book, and then 
choose a sorting subtopic that interests you. 

Finding Individual Records 
Scrolling through records is fine for browsing. But when you're in a hurry, you'll prob
ably want to use these search techniques to find specific data in your table: 

1. Open the table, query, or form that contains the data you're looking for (if it isn't 
already open). You can use either datasheet view or form view-it doesn't matter 
which. 

2. If you want to search only one specific field, click on that field. The Find feature 
can search fields that have any data type except Yes/No, OLE Object, or Lookup. 

3. Click on the Find toolbar button (shown at left). Or choose Edit ~ Find or press 
Ctrl+F. Or right-click on the column selector (in datasheet view) and choose Find 
from the shortcut menu. You'll see the Find In Field dialog box shown below. 

Fond in held 'lastName' iJ EJ 

Match: I whole FJeld 
F.QCmal.led 

E1 1;1 So"'ch 0~ WI~ Field 
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# 
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4. Type the text you want to look for in the Find What text box (for example, Niktog). 
To make the search more general, you can include the wildcard characters listed in 

Table 9.1. 

TABLE 9.1: WILDCARD CHARACTERS YOU CAN USE IN THE FIND WHAT TEXT BOX 

WILDCARD STANDS FOR EXAMPLE 

Any single character Sm?th matches Smith, 
Smyth, Smath, and so on. 

Zero or more characters Sm* matches Smith, Smith-
ereens, Sm'ores, Sm. 

Any numeric digit 9## Oak St. matches any 
addresses in the range of 900 
Oak St. to 999 Oak St. 

Any characters in Sm[iy]th matches Smith or 
the brackets Smyth, but not Smath. 

Any characters within the [N-Z] matches any text start-
range (must be within ing with the letters N 
brackets) through Z, provided that 

you also select Match ~ Start 
Of Field. 

Any character except [!N-Z] matches any text that 
(must be within brackets) doesn't start with the letters 

N through Z, provided that 
you also select Match ~ Start 
Of Field. 

1111 (two double-quotes) Zero-length strings 1111 matches zero-length 
strings, provided that you 
also select Match ~ Whole 
Field. 

Null or Is Null An unformatted blank field Null matches empty fields, 
provided that you also select 
Match ~ Whole Field and 
have not selected (checked) 
Search Fields As Formatted. 

Cll 

"' 11:1 
.a 

11:1 .... 
11:1 
0 

11:1 

c:n c 
~ 

11:1 

~ u 
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S. Select or deselect the Match Case, Search Fields As Formatted, and Search Only 
Current Field options; choose a search direction (Up, Down, or All) from the Search 
drop-down list; and choose a match option (Whole Field, Any Part Of Field, or Start 
Of Field) from the Match drop-down list as needed. Note: If you're searching in a 
lookup field and the Match box is set to Whole Field or Start Of Field, be sure to 
select (check) Search Fields; otherwise the search will fail. 

By default, the Find and Replace features do a "Fast Search" in which Access 
searches the current field and matches the whole field. To change the default set
ting, choose Tools > Options, click on the Edit/Find tab in the Options dialog 
box, and then choose an option under Default Find/Replace Behavior. For more 
details, see Chapter 15 or click on the ? button in the Options dialog box and 
then click on the Edit/Find option you're curious about. 

6. Start the search by clicking on the Find First button (to find the first occurrence of 
the text in the table) or the Find Next button (to find the next occurrence relative 
to the cursor position). 

Access will find the first record (if any) that matches your request. If the dialog box 
is covering data that Access has found, drag the box out of the way. 

Repeat steps 4 through 6 (or click on Find Next) until you've found the record you 
want. If Access tells you it can't find the search item, click on OK to end the search. 
When you're done searching, click on Close or press Esc to close the dialog box. 

After closing the Find dialog box, you can press Shift+F4 to find the next occur
rence of text you last searched for. 

For more help on finding records, go to the Access Help Contents, open the Finding 
And Sorting Data book, open the Finding Records Or Data book, and then choose the sub
topic you're interested in. 

Fixing T~pos Automatic all~ 
If you're not such a hot typist, you'll be happy to know that Access can check and correct 
your spelling automatically as you type, or anytime you wish. You'll learn next about 
the AutoCorrect and Spelling features, which can search out typing mistakes and ren
der them harmless. 
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The AutoCorrect and Spelling features in Access are almost identical to the ones 
you'll find in other Microsoft Office programs, including Word and Excel. 

Correcting Mistakes As You Type 
If you frequently find yourslef typng (oops, yourself typing) certain words incorrectly, or 
you often want to replace abbreviations (such as CEFGW) with their longer forms 
(Close Enough For Government Work), the AutoCorrect feature can help you . You sim
ply teach AutoCorrect the word or abbreviation it should replace and then provide its 
replacement word or phrase. In the future, Access will substitute the typo or abbrevia
tion with its replacement word or phrase. AutoCorrect also can correct capitalization 
errors that occur when you type TWo INitial CApitals (instead of just one) in a word or 
you forget to capitalize names of days. 

Adding new words to the list of automatic replacements has no effect on existing text. 

Setting Up AutoCorrect Words and Settings 
To teach Auto Correct new words or to change the AutoCorrect settings, open any data
base object or go to the database window. 

I. Choose Tools ,.. AutoCorrect. Figure 9.3 shows a sample AutoCorrect dialog box 
after we filled in the Replace and With boxes. (Notice that Access comes with an 
extensive list of commonly mistyped words that it can replace automatically.) 

2. Use these techniques to turn AutoCorrect features on or off: 

• To replace two initial capital letters with just one initial capital letter, select 
(check) Correct TWo INitial CApitals. Deselect this option to prevent auto
matic replacement when you type two initial capital letters. 

• To capitalize the first letter of a sentence, select (check) Capitalize first letter of 
sentence. Deselect this option to keep Access from capitalizing the first letter in 
each sentence. 

• To capitalize names of days if you forget to do so, select (check) Capitalize 
Names Of Days. Deselect this option to prevent automatic capitalization when 
you type day names. 

• To have Access notice when you type with caps lock on by mistake, select 
(check) Correct accidental use of cAPS LOCK key. 

I I 
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MilftQ;tQM 
Use the Auto
Correct dialog 

box to custom
ize the way 

Access replaces 
text automati

cally as you type 
into text or 

memo fields. 
Choose Tools ~ 
AutoCorrect to 

get here. 

Replace 
these wor ds ... 

AutuConeol fl £j 

AutoCor red 

P Cl!fl'e<t TWo INitial CApitals !;;xceptions... I 
P Capitalize first letter of ~ntence. 

P Capitaize names of days 

P Corre<t eccldental use ri cAPS ~OCJ< l<ey 

rP Replace text as you type 

&eplace: With: 

jCEFGW 
= 

I J J~OSI!! e~lJQh lor gover'ronent wor~ ____ ,J 
cafe cafe 

~ : Corljt i c~nt 
.,,, •. ·~.f been I cant ~ve been 

~· capitol cty 
1 
c•pt•l crly 

ch""QSir~ •chong01g 
thM~er _j dl~~n~cter 

111

1 I add I UF.-Iete I 
= 

OK I Cancel I 

• 

with these words 

• To replace words shown in the left column of the AutoCorrect dialog box with 
words shown in the right column, select (check) Replace Text As You Type. Dese
lect this option to prevent automatic replacements as you type. 

3. Use these techniques to add, change, and delete words in the replacement list: 

• To add a new word to the replacement list, type the misspelling or abbrevia
tion into the Replace text box. Then type the correction or expanded form of 
the word into the With text box. Click on Add to add the items to the list. 

• To change a word or its replacement, scroll to and then click on the appro
priate word in the list below the Replace and With text boxes (the words are 
listed in alphabetical order). The Replace and With boxes will show the item 
you selected. Change th e Replace or With text as needed, and then click on the 
Add or Replace button (whichever is available) to update the list. 

• To delete a word and its replacement, scroll to and click on the appropriate 
word in the list. Then click on the Delete button. 

4. Repeat steps 2 and 3 as needed. When you're finished using the AutoCorrect dialog 
box, click on OK. 
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You can add new words to the AutoCorrect list during a spell check. See "Check--..a ing Your Spelling" for details. 

Using AutoCorrect during Data Entry 
As you type new text or paste a word or abbreviation into a text or memo field, Auto
Correct will fix typos or expand abbreviations automatically. (AutoCorrect has no effect 
on existing text.) The automatic correction takes place when you type a space or punctu
ation mark in the field or move the cursor to another field. 

If you need to cancel an automatic replacement as you're typing, press Ctrl+Z (or 
choose Edit> Undo AutoCorrect); the text will reappear as you typed it. To reinstate 
the automatic correction, press Ctrl+Z again (or choose Edit> Undo). 

Need more information? Go to the Access Help Contents, open the Working With 
Data book, open the Checking Spelling And Automatically Correcting Errors As You Type, 
and then explore the automatic correction subtopics as needed. 

Checking Your Spelling 
Access can check and correct the spelling in text or memo fields of a datasheet, or in 
selected text in a datasheet or form. The spell check ignores fields that don't have a Text 
or Memo data type. 

Here's how to start a spell check: 

1. Do one of the following, depending on how much text you want to spell check: 

• To check spelling in datasheet view, select the records, columns, fields, or 
text within a field. 

• To check spelling in form view, select the field or text within the field you 
want to check. 

• To check all text and memo fields in a table, go to the database window, click 
on the Tables or Queries tab, and then click on the table or query you want to 
check. Or open the table or query in datasheet view and select all the columns. 

2. Click on the Spelling toolbar button (shown at left) or choose Tools > Spelling or 
press F7. Spell checking will start immediately. 

3. Follow the screen prompts. Once spell checking begins, what you do next depends 
on what (if any) errors are found (see "Correcting or Ignoring a Word" below). 

4. Click on OK to clear the completion message when the spell check is complete. 
II 
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M#tftQ;liQM 
The Spelling 

dialog box after 
Access found a 

word that 
wasn't in the 

dictionary. 

Correcting or Ignoring a Word 
When the spell checker finds a word that isn't in its dictionary, it will highlight the 
word in your datasheet or form, suggest a correction if it can, and pause so you can 
decide what to do next. Figure 9.4 shows the Spelling dialog box after it tripped over 
the word Foosball, which isn't in its dictionary. 

You can click on any of these buttons (if they're available) when the spell checker is 
waiting for you to make a correction: 

Ignore 'xxx' Field (where xxx is a field name). Click on this button to ignore the 
named field during the current spell check. Spell checking will continue. 
Ignore or Ignore All Click on Ignore to ignore the current occurrence of the word 
shown in the Not In Dictionary box. Click on Ignore All to ignore all occurrences of 
the word shown in the Not In Dictionary box. Spell checking will continue. 
Suggest Click on the Suggest button, or type a word into the Change To box and 
then click Suggest, to see alternatives to the word shown in the Change To box. To 
copy one of the suggested words into the Change To box, click on the word you want 
to copy in the list next to Suggestions. You can repeat these steps as needed. 
Change or Change All Lets you replace one occurrence (Change) or all occur
rences (Change All) of the word shown in the Not In Dictionary box with the 
word shown in the Change To box. If necessary, use the Suggest button described 
above or type a word into the Change To box or click on a word in the Sugges
tions list to copy the word you want to use as the replacement word into the 
Change To box; then click on the Change or Change All button, as appropriate. 
Spell checking will continue. 

• 
Spelhng £S 

Nat In Dictionary. jFoosball 
Chango!o: ~=-__:=:=:=:::=----

Suggeslioos: lgno~e 'ProductName' field I 
Ignore Ignore AI 

..:J _....;.&ld _ _. 
Add~onls To: r:::IC-us:-tom~D~,c-----3..., 

Aut.oCotrect Qptions... I._..:::.....:::........J __ c..nce~ _ __. 



FIXING TYPOS AUTOMATICALLY 1319 

Add Lets you add the word shown in the Not In Dictionary box to the spelling 
dictionary that's shown in the Add Words To box. If necessary, choose a diction
ary name from the Add Words To drop-down list before you click on the Add 
button. (Do not add words that truly are misspelled to your dictionary! See the 
sidebar titled "Maintaining Custom Dictionaries" for more details.) 
AutoCorrect Adds the word shown in the Not In Dictionary box to the Auto
Correct dictionary and assigns the word in the Change To box as the replacement 
word. This button saves you the trouble of manually adding words that you com
monly mistype to the AutoCorrect dictionary (as explained earlier in this chapter). 

If you add a word to the AutoCorrect dictionary accidentally, complete the spell 
check (or cancel it). Then choose Tools ~ AutoCorrect, highlight the incorrect 
word in the replacement list, and click on the Delete button. 

Options Takes you to the Spell Options dialog box (shown below). From here 
you can choose which language Dictionary to use and choose whether to 

• Always Suggest alternate spellings or suggest them only when you click on the 
Suggest button 

• Suggest words From Main Dictionary Only, or offer suggestions from both 
the main dictionary and the custom dictionary 

• Ignore Words In UPPERCASE (such as ASPCA), or include those words when 
spell checking 

• Ignore Words With Numbers (such as RNAA47) or include those words when 
spell checking 

lflJ Options £I 

OK 

Cancel 
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Maintaining Custom 
Dictionaries 
You can create a custom dictionary any
time you're using the Spelling dialog box. 
This trick can be handy if you want to set 
up a new custom dictionary for storing 
special-purpose terms. To create a custom 
dictionary: 

1. In the Spelling dialog box, erase any 
dictionary name that appears in the 
Add Words To combo box. 

2. Type a valid dictionary name and 
press Enter or choose an existing cus
tom dictionary from the combo box's 
drop-down list. The default dictionary 
name is custom.dic, but you can use 
any name for your dictionary as long 

as that name ends with a period 
and the letters die. For example, 
mywords. di c and medical terms. di c 
are valid dictionary names. 

3. If Access asks for permission to create 
the dictionary, click on Yes. 

The custom dictionary is a plain text file 
that lists one word per line in alphabetical 
order by word. Custom dictionaries are 
stored in the folder \Program Files \Co11111on 
Fil es\Mi crosoft Shared\ Proof on drive C 
(if you chose the default installation loca
tion). If you add a misspelled word to a 
custom dictionary by accident, you can 
use Windows Notepad or Windows Word
Pad (in text mode) to delete the incorrect 
words. Edit carefully! 

After choosing options in the Spell Options dialog box, click on OK. 

.. 

Undo Last Lets you undo the most recent change the spell checker made. Click 
on this button as necessary to back out of changes one by one. 
Cancel Ends the spell check and returns you to the datasheet or form. 

For more details about spell checking, go to the Access Help Contents, open the 
Working With Data book, open the Checking Spelling And Automatically Correcting Errors 
As You Type, and then investigate the spelling subtopics. 

Replacing Data in Multiple Records 
In addition to letting you fix spelling errors in some or all text and memo fields, Access 
lets you instantly change the contents of a field throughout all (or some) of the records 
in your table. But before you even think of experimenting with this Replace feature, 
please make sure you understand the following warning. 
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You can Undo only the last individual change that Replace makes. To play it safe, 
make a copy of the table before you replace data. That way, if you make a major 
mistake, you can close the table and then rename the unchanged original copy of 
the table to write over the version that has unwanted changes. See Chapter 1 for 
help on copying and renaming database objects. 

To replace data in a table: 

1. Open the table, query, or form that contains the data you want to change. 
2. (Optional) If you want to limit replacement to a single field, click on that field. The 

Replace feature can replace text in fields that have any data type except OLE Object, 
AutoNumber, and Lookup. 

3. Choose Edit~ Replace or press Ctrl+H. You'll see the Replace In Field dialog box 
shown below. 

Aeplu(:u m held "ProductName" l] EJ 

::J r M..tch .t;ase 

r ~..n Wl:P!llif'"~kl 
R Search Only Cun_!!nt Field 

l Eind Next I 
a~ I 

Aep\6oe81 I 
Clote I 

4. Type the value you want to search for and change in the Find What text box. You 
can use the wildcard characters listed in Table 9.1 if you wish. 

S. Type the replacement text in the Replace With text box. 
6. Select or deselect the Match Case, Match Whole Field, and Search Only Current 

Field options, and choose a search direction (Up, Down, or All) from the Search 
drop-down list as needed. Then do one of the following: 

• To make the change automatically (so that Access won't ask you to verify 
each occurrence), click on the Replace All button. 

• To verify the changes in each record, click on the Find Next button. (If neces
sary, drag the dialog box out of the way so you can see what data Access is 
about to change.) Then if you do want to change the current record, click on 
Replace. If you don't want to change the current record, click on Find Next. 
Repeat this step as needed. 
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7. Click on Yes to continue with step 9 or click on No to cancel the operation and 
return to steps 4, S, or 6. 

8. When Access cannot find any more matches, it will display a message. Click on OK 
to clear the message. 

9. Click on the Close button when you're done replacing records. 

Here are some tips you might want to know about: 

• To globally replace large amounts of data more quickly, or to perform calcula
tions on data (for example, raising certain product prices by 10 percent), use an 
Update query rather than Replace. See Chapter 10 for more about Update queries. 

• To change the default settings for the Find and Replace features, choose Tools ). 
Options and click on the Edit/Find tab. Change the settings under Default Find/ 
Replace Behavior as needed and then click on OK. Chapter 15 explains more 
about personalizing Access. 

A Search-and-Replace Example 
Suppose that several people enter data into your table. Some of them spell names such 
as Los Angeles in full, while others use abbreviations such as L.A. This type of inconsis
tency is sure to cause problems down the road. Imagine that you want to send a form 
letter to all Los Angeles residents. If you isolate records that have Los Angeles in the 
City field, you 'll miss all the ones that contain L.A. Why? Because computers aren't 
smart enough to know that Los Angeles and L.A. mean the same thing. 

Anyway, the cure for your dilemma is to change all the L.A. entries in the City field 
to Los Angeles (or vice versa). To do that, click on the City field, choose Edit). Replace, 
and then fill in the dialog box this way: 

Replace m held 'Coty' HEJ 

F{ld\Nhat: 

2J P' Match.!;;ase 

P' Motch ~le Field 
P' Search 0 nly Currjlnt Field 

fmd NClll 

fieplace 

~ 
To start the replacement, click on the Replace All button and bingo-you're done! 

Oust answer any questions that appear on the screen.) 
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To prevent the L.A. city names from creeping into your data in the future, you 
might want to add an AutoCorrect entry that changes "L.A." to "Los Angeles" 
automatically. See "Correcting Mistakes As You Type" earlier in this chapter. 

If you ever need reminders or help while replacing data, go to the Access Help Index 
and look up Replacing Values In Fields . 

Filtering Out Unwanted Records 
You can use filters to temporarily isolate (or select) records you want to see and to hide 
unwanted records. For example, you can focus on your California customers while 
hiding information about customers located in other states. There are several ways to 
create a filter: 

• Filter By Input lets you create a filter from a field's shortcut menu. 
• Filter By Selection and Filter Excluding Selection let you create a filter by select

ing text or clicking in a field that contains the text you want to filter. 
• Filter By Form lets you create a filter by typing the values you're looking for into 

a fill-in-the-blanks form or datasheet. 
• Advanced Filter/Sort lets you use a window that's similar to a query design win

dow to create a filter. You can choose each field to search or sort by and specify 
the sort order and values you're looking for. 

You can filter fields that have any data type except Memo or OLE Object. 

Table 9.2 compares the four filtering methods briefly, and the following sections 
explain how to use each one. If you still need more information, go to the Access Help 
Index and explore the subtopics under Filters. 

To swi tch between designing a Filter By Form and designing an Advanced Filter/ 
Sort, open the Fil ter menu in the design window for either type of filter and then 
choose Fil ter By Form or Advanced Filter/Sort as appropriate. 
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I TABLE 9.2: FILTERING METHODS COMPARED ., 

If This Is Filter by 
What You Filter by (Or Excluding) Filter by Advanced 

Want To Do ... Input Selection Form Filter/Sort 

Find records Yes (if you Yes (if you spec- Yes Yes 
that meet one specify the ify the criteria one 
criterion And criteria one at at a time) 
other criteria a time) 

Find records No No Yes Yes 
that meet one 
criterion Or 

other criteria 

Find records Yes No Yes Yes 
that contain 
expressions as 
criteria 

Find records No No No Yes 
and sort them 
in ascending or 
descending 
order at the 
same time 

Filtering by Input 
Filter by Input is a new Access feature that lets you use a field's shortcut menu to find 
records. You can use it for filters, such as finding all the records with "CA" in the State 

field . Filter by Input also works for more complicated filters that use comparison oper
ators, wildcards, or functions. For example, you can use ">t" in a filter on the Last Name 
field to limit the records you view to those that begin with letters after T. Or you can use 
"D*" in the First Name field to see all records for people whose first name begins with D. 

To use Filter by Input: 

1. Open the table, form, or query you want to filter. 
2. Right-click anywhere in the field you want to use for the filter except in the field 

header. 
3. Enter a value in the box after Filter For: and press Enter. 
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To see other examples of valid filter expressions, search the Access Help Index for Filters, 
Criteria to Select Records and then look up Examples of Expressions Used in Queries and Filters. 

Filtering by Selection or Exclusion 

Let's suppose you've found a record that contains some data you're looking for

perhaps an order for tether balls in the Order Details table. Now you want to find all the 
other orders for that product, or all the orders for products except tether balls. Access 
makes jobs like these ridiculously easy: 

1. Open the table, query, or form you want to filter (in datasheet view or form view). 
2. Locate the record and field that contains an instance of the data you want Access 

to filter. For example, in the Order Details table, locate a record that displays the 
value Tether ball in the ProductiD field. 

3. Tell Access how much of the field to match: 
• To match the entire field, select the entire field or click in the field without 

selecting anything. Example: To match Tether ball (the entire field), click in a 
field that displays a value of Tether ball as shown below. 

• To match part of a field, starting with the first character in the field, select 
text starting at the beginning of the field (see below) . Example: To match fields 
that start with Foo, highlight Foo at the start of a field. Items such as Football, 
Fousball, and Foot Powder will match. 

Record: ..!!.l..!J I 
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• To match part of a field, after the first character in the field, select text 
within the field. Example: To match fields that contain ball (preceded by a 
space), highlight the word ball and the space that appears before ball, as shown 
below. Items such as Crystal ball and Tether ball will match, but Football and 
Foosba/1 will not (because there's no space before ball in those item names). 

In the above example, Access will not match Golf balls when you apply the filter 
.__ ... because the pattern "ball" doesn't fall exactly at the end of the field. To isolate 

Golf balls along with Crystal ball and Tether ball, select "ball" in a record that con
tains Golf balls in the ProductiD field. This forces Access to use a more general pat
tern that says "Find the word ball preceded by a space anywhere in the field," 
rather than the less general pattern "Find the word ball preceded by a space at 
the end of the field." 

4. Do one of the following to apply your filter: 

• To show only records that have matching values in the field, click on the Fil
ter By Selection toolbar button (shown at left) or choose Records ~ Filter ~ Filter 
By Selection or right-click on the field and choose Filter By Selection. 

• To show only records that do not have matching values in the field, right
click on the field and choose Filter Excluding Selection. (Access will filter out 
records that contain null values in the field as well as records that contain val
ues that match the current field or selection.) 

The datasheet view or form view will instantly reflect your filtering choices. The nav
igation bar at the bottom of the datasheet or form window displays (Filtered), and the 
status bar shows FLTR, to remind you that you're looking at a filtered view of data. 
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To filter the remaining records even more, simply repeat steps 2 through 4 as needed. 
You also can use the sorting techniques discussed earlier in this chapter to sort or alpha
betize the records. 

When you apply a filter, you're actually setting the Filter property for the table query 
............. or form. To view this property, switch to design view, and then choose View>- Prop

erties or click on the Properties toolbar button. If you're viewing form design proper
ties, click on the Data tab on the property sheet. If you're viewing query properties, 
click in the gray upper part of the query design window. 

Removing or Reapplying a Filter 
It's easy to remove a filter or reapply it at any time: 

• To remove (or reapply) the filter only, click on the Remove Filter toolbar button 
(shown at left). This button is a toggle-you click on it to remove the filter (the but
ton will appear pushed out), and you click on il again to reapply the filter (the 
button will appear pushed in). The SmartTip under the button will flip-flop 
between Remove Filter and Apply Filter, to reflect what action the butt n will take 
when you click on it. 

• To remove both the filtering and sorting, right-click on any data field and 
choose Remove Filter/Sort. Or choose Records .. Remove Filter/Sort. 

The steps given above for reapplying and removing a filter work for all types of filters
Filter By Selection, Filter Excluding Selection, and Advanced Filter/Sort. You also can 
remove filters and sorting by clearing the Filter and Order By properties, respectively, 
on the property sheet in table design, query design, or form design view. 

Saving Your Filter with the Datasheet or Form 
You an save the fi lter so that Ac swill remember it the next time you open your 
table, query, or form. The fo llowing steps work for all types of filters-Filter By Selec
t ion, Fil t r Ex:cludlng Selecti on, and Advanced Filter/Sort: 

1. Return to the datasheet window or form window. 
2. Click on the Save toolbar button or press Ctrl+S or choose File .. Save Layout or File .. 

Save; or close the datasheet and click on Yes when asked if you want to save changes 
to the design. 
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Access automatically saves filters applied to a form when you close the form. There
!lilo.iii:o-.. ... fore, you don't have to explicitly save a form to use the filter the next time you open 

the form. Simply click on the Apply Filter button (or its equivalent menu options 
and right-click shortcuts) to reapply the last filter you used. 

The next time you open the datasheet or form all the data will appear. To filter the 
data again, click on the Apply Filter button. 

To create a form or report that automatically inherits the filter you've saved with a 
datasheet, open the datasheet, apply the filter and click on the Save toolbar but
ton. Then click on the drop-down arrow next to the New Object toolbar button 
and choose the AutoForm, AutoReport, Form, or Report option. 

Filtering by Form 
If you prefer a fill-in-the-blank method for designing your filters, try the Filter By Form 
feature. Here's how to use it: 

1. Open the table, query, or form you want to filter (in datasheet view or form view). 
2. Click on the Filter By Form tool bar button (shown at left) or choose Records> Filter> 

Filter By Form. If you're in datasheet view, you'll see a blank, one-row datasheet, 
as shown in Figure 9 .5. If you're in form view, you'll see a blank form instead (see 
Figure 9.6). 

3. Click in the field you'll use to specify criteria that records must meet to be included 
in the filtered set of records. 

A criterion is a set of limiting conditions, such as tether ball or >47, in a query or filter. 
One or more criteria are used to isolate a specific set of records. 

4. Enter criteria by selecting the value you're searching for from the drop-down list in the 
field (if the list includes values) or by typing a value or expression into the field. In a 
moment, we'll give you some tips and tricks for filling in the fields. You'll learn more 
about entering expressions in the later section on "Using Advanced Filter/Sort." 

5. Repeat steps 3 and 4 as needed to specify additional criteria that must be true in 
any given record that makes it through the filter. 



.#t3II;IQM 
The Filter By 

Form window 
shown as a one

row datasheet, 
after we opened 

the list for the 
Product/0 field. 
Notice the Look 
For and Or tabs 

at the bottom of 
the window. 

Wllijij;IH.W 
The Filter By 

Form window 
shown as a 
blank form, 

after we filled in 
some values 
and opened 

the list for the 
EmployeeiO 
field. In this 

example, the 
bottom of 

the main form 
and subform 
includes Look 

For and Or tabs. 

FIL TERING OlJT UNWANTED RECORDS 1329 

Basketball 
Billiard ba ll s 
Crystal ball 
Football 
Gcdiball ; 

t!ll OrdeJJ: Fillor ~Y Form l!lliJEJ -----------------------------------------------------------

------produ ~l~z•Jh:., Lane 
Honcho, Ed 
Lill ,l>.nila 
N iktog, .6Jber t 
Niklog, Emil~· 

~~~£!.....-=---!· S•i·lipple, ,l oceph 
Von No, lo, Amlr~~ 

Sale$ T .:J;.; Rate 

Order Date 

~·htp 0 -3te 

S hipp1r19 H eth•:,::J 

l;s 

OrdoiiO 

Fre1ght [h.:Jrge 

~.a l o:>~ Tax 

Order T (• t~l 

T ·:~ l:~l P.:,ym e~ .t ~ 

,t._moJIJill ( 111.:0 

• 

• 

6. C lick o n an Or tab at the bottom of Lhc window if you w;~nt to specify alternative 

values that records can have in order to m ake it through the filter; then specify cri

teria for that tab by repeating steps :~ and 4 as m·cdcll. Yo u can continu e sett in g up 

more Or criteria, and you can flip to a different tab by clicking on it. 

<IJ 
VI 
~ 

.!:l 
~ 
+" 
~ 

Cl 
~ 

0'1 
c 
~ 

r<:l 
<IJ 
"-u 



330 CHAPTER 9 • SORTING, SEARCHING, FILTERING, AND PRINTING 

Think of additional values shown on the same tab as meaning "And." For example, 
to include orders in which the product ordered is tether ball and the quantity ordered 
is 5, specify tether ball in the ProductiD field and 5 in the Quantity field. To also see 
orders for 2 of any item, click on the Or tab and type 2 in the Quantity field. 

7. Click on the Apply Filter toolbar button when you're ready to apply the filter or 
choose Filter Apply Filter/Sort from the menus. 

Access will filter the records as you asked and display them in the datasheet or form. 
As for Filter By Selection, you can remove the filter and save the filter from datasheet 
view or form view as needed. 

Filtering by Form-an Example 
Let's look at an example that will show how easy it is to use Filter By Form. Suppose you 
want to isolate records in the Order Details table in which customers ordered five (5) 
tether balls. You also want to see any order for basketballs, or any order for two (2) or 
more crystal balls. Here are the steps: 

1. Open the Order Details table in datasheet or form view (we'll use datasheet view for 
our example). 

2. Click on the Filter By Form toolbar button. 
3. Type tether ball (if you're using the sample data that Access provided, typing t is 

enough to display tether ball in the field) in the ProductiD field. 

Filters usually are not sensitive to uppercase and lowercase letters, so you don't 
have to worry about them either. Thus you can search for tether ball or Tether Ball 
or TETHER BALL and so forth. Remember, however, that spaces are important, so a 
search within our sample data for tetherball will fail. (Filters on attached data 
might be case-sensitive. For example, SQL Server can be configured to be either 
case-sensitive or case-insensitive.) 

4. Type S in the Quantity field. The Filter By Form window looks like this: 
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5. Click on the Or tab at the bottom of the Filter By Form window, click in the Pro
ductiD field, and then type basketball (or just bask, given our sample data), as 
shown below: 

6. Click on the next Or tab at the bottom of the window, click in the ProductiD field, 

type crystal ball (or just c), click in the Quantity field, and then type >=2 (which 
means greater than or equal to 2). Here's what you'll see: 

7. Click on the Apply Filter tool bar button to see the results. 
8. Select the ProductiD and Quantity columns and then click on the Sort Ascending 

toolbar button as a finishing touch. This step sorts the results by ProductiD and 
then by quantity within the same ProductiD. 

Figure 9.7 shows the Order Details datasheet after we did the eight steps above. As 
you see, we've isolated all basketball orders, crystal ball orders of two or more, and 
tether ball orders of five. 

Record: .!!l!../1 
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X 

Tips and Tricks for Using the Filter By Form Window 
These tips and tricks can help you use the Filter By Form window more efficiently: 

• To clear all fields in the Filter By Form window, click on the Clear Grid toolbar 
button (shown at left), or choose Edit>- Clear Grid. 

• To delete an Or tab at the bottom of the Filter By Form window, click on the 
tab you want to delete and then choose Edit >- Delete Tab. 

• To get quick help with using the Look For or the Or tabs on the Filter By Form 
window, click on the Help toolbar button or press Shift+Fl; then click on the tab 
you need help with. 

Speeding Up when Filtering by Form 
Using Filter By Form will be fast on small tables, but it might be slow on very large ones. 
Fortunately, you can speed up overall performance for Filter By Form or optimize per
formance on individual forms. 

If lists seem to display slowly while you're creating a Filter By Form filter, you can 
change some settings to speed things up. To speed up Filter By Form list performance 
for all tables, queries, and forms, choose Tools >- Options and then click on the Edit/ 
Find tab. Check or clear options in the Show List Of Values In group; then enter a max
imum list size to display when you open a drop-down list for a field value. The more 
options you check and the more items you show in lists, the slower your filter will dis
play the drop-down lists when you create the filter. Click on OK when you're done 
making changes. 

You also can speed up performance when displaying Filter By Form lists for text box 
controls on a specific form. To begin, open the design window for the form, choose 
View >- Properties, and then click on the Data tab in the property sheet. For each text 
box control you want to optimize, click on the text box control and then choose an 
appropriate Filter Lookup property. Your options are 

Database Default Use the settings shown on the Tools >- Options >- Edit/Find tab. 
Never Never show available values in the drop-down list for this field; instead, 
show only Is Null and Is Not Null in the list. 
Always Always show available values in the drop-down list for the field. 

Perhaps an example can help you decide when to turn off Filter Lookup for a field on 
a form. Suppose you work for a huge company, and you often use Filter By Form to 
select employees who have a particular last name. Because you rarely use the FirstName 
field's drop-down list when filtering by form, you can speed things up by setting the 
FirstName field's Filter Lookup property to Never. With this setting, an accidental click 
on the FirstName field's drop-down list won't bog you down while Access creates a long 
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list of first names that you don't need to see anyway. (Of course, you can always click 
in the FirstName field and type a first name value if you occasionally want to filter by 
first name.) 

If you often use the same nonindexed field to filter your data, consider adding an 
index to that field, as explained in Chapter 6. 

Using Advanced Filter /Sort 
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The Advanced Filter/Sort feature can be convenient to use if you need to create com
plex filters. With Advanced Filter/Sort you can sort fields and specify selection criteria 
all at once, without having to switch from tab to tab (as with Filter By Form). To use it: 

1. Open the table, query, or form you want to filter, in datasheet view or form view. 
2. Choose Records >- Filter >- Advanced Filter/Sort. The filter design window, shown 

in Figure 9.8, will appear. 

You can view and update the "advanced" filter that's behind a Filter By Selection, 
Filter Excluding Selection, or Filter By Form at any time. just create one of these 
filters as explained earlier in the chapter, and then choose Records >- Filter )o

Advanced Filter/Sort or Filter )o- Advanced Filter/Sort (depending on which options 
are available on the menu bar). 

• 
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3. Drag the name of a fi eld you want to search or sort by from the list in the upper 
pane of the window into the QBE grid in the lower pane of the window. Or double
click on a field to copy it to the next available Field cell in the QBE grid. 

QBE is short for query-by-example, so named because you query (ask for) certain 
records by presenting examples of what you want. (The search criterion you enter 
is the "example.") The QBE grid for a filter is similar to the QBE grid for a query 
(see Chapters 3 and 1 0) . 

4. Choose either Ascending or Descending from the Sort cell if you want to sort the 
records by the fi eld you specified in step 3. 

5. Type the value you're looking for into the Criteria cell under the field name. 

1
-A::Ss ... may translate your criteria into syntax it understands by adding quotation 

:o-.,.;::....;, marks or other punctuation marks to whatever you type into the Criteria cells. Usu
ally you can enter criteria without the quotation marks or other punctuation marks, 
although it's perfectly fine to type them yourself. The examples in Table 9 .3 (later 
in this chapter) show ways to enter equivalent criteria with and without punctua
tion marks. 
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6. Repeat steps 3 through 5 to specify as many criteria as you wish. (We'll explain more 
about how to enter criteria under "Creating Complex Filters" later in this chapter.) Fig
ure 9.9 shows the QBE grid after we copied the ProductiD and Quantity fields to the 
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7. Click on the Apply Filter/Sort toolbar button when you're ready to apply the filter, 
or choose Filter> Apply Filter/Sort. 

Any records that do not meet the criteria you specified will just disappear from view. 
But don't worry-they're only hidden, not gone. The navigation bar shows (Filtered) and 
the status bar includes an FLTR indicator, to remind you that some records are hidden. 

As for Filter By Form and Filter By Selection, you can remove the filter set up with 
Advanced Filter/Sort (click on the Remove Filter toolbar button), and you can save the filter 
with your datasheet or form (click on the Save toolbar button in datasheet or form view). 

When you remove the filter, all the records in the table will be accessible again, and 
the (Filtered) and FLTR indicators will disappear. To reapply the filter, simply click on the 
Apply Filter toolbar button. 

Using lookup Fields in Filters 

Entering Criteria values for a lookup field 
can be trickier in an Advanced Filter/Sort 
than it is in the simpler filters discuss d 
earlier. That's because, in lho e simpler 
filters, Access reCites an Internal lookup 
query that joins lookup fields to their 
related table~ and plugs in appropriate cri
teria values. To see this for your ell, create 
a Filter Sy Selection, Filter Excluding 
Selection, or a Filter Sy Form filter that 
selects values ln a lookup field (such as 
ProductiD), and apply lhe Filter. Then 
choose Records > Filter > Advanced 
Filter/Sort to see the internal query that 
Access created automatically. 

With lhe Advanced Filter/Sort feature, 
only one table (the table you're creating 
lhe filter for) usually appears ir1 the filter 
window. Secause you don't have the con
venience of displaying v~Jues from the 
internal lookup query, you must enter 
(into the QBE grid's Criteria cell) the value 
that' act;ually stored In the lookup field, 
not lhe value shown when you're viewing 
lhe lookup field in a datasheet or form. In 
Figure 9.9, for example, we wanted to iso
late orders for tether bolls. To do that, we 
had to type 9 (the ProductiD of a lether 
ball )-no lhe word tether ball-into lhe 
Cnteria cell below ProducLID. 

See Chapter 6 for more about lookup 
fields and Chapter 1 0 for more about 
automatic joins between tables. 

Creating Complex Filters 
When filtering your records, you're not limited to looking for one valLie In oue field. 
The fact is, you can isolate records based on the contents of any combination of fields 
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in the table. For example, you can select "all the orders that were placed within the last 
60 days by companies in Bellevue, Washington, or Jackson, Mississippi." 

You can set up the same criteria with either Filter By Form or Advanced Filter/Sort. 
,....... __ ... The main difference between these filtering methods is that Advanced Filter/Sort lets 

you see all your criteria at once, whereas you must switch from tab to tab to see the 
Or conditions in a Filter By Form filter. Also, Filter By Form doesn't offer built-in sorting 
(but, after applying the Filter By Form filter, you can arrange columns you want to 
sort by from left-to-right, select them, and then click on the Sort Ascending or Sort 
Descending toolbar buttons). 

Choosing Fields to Filter 
When setting up an Advanced Filter/Sort, you first need to tell Access which fields to filter 
or sort by copying field names from the field list into the QBE grid (see Figure 9.8). You've 
already learned two ways to copy field names, but here's the complete list of techniques 
for reference: 

• To locate a field name in the field list, click in the field list and type (as many 
times as needed) the first lette.r of the field name you want to see, or use the verti
cal scroll bar. 

• To copy a field name into the QBE grid, double-click on the field name in the 
field list or drag it from the field list to the first row (see Figure 9.9). Or click in an 
empty Field cell in the QBE grid and then type the first few letters in the field 
name. Or click in the Field cell, click on the drop-down arrow button that 
appears, and then scroll to and click on the field you want to copy. 

• To copy several field names to the QBE grid, Shift-click to select multiple adja
cent field names in the field list or Ctrl-click to select nonadjacent field names. 
Then drag any one of the selected field names into the QBE grid. 

• To copy all the field names from the field list into the QBE grid, double-click 
on the title at the top of the field list and then drag any selected field name down 
to the QBE grid. 

Specifying Selection Criteria 
The selection criteria tell Access what you're looking for. To specify criteria, you type an 
expression in the Criteria cell under a field name. The expression can be the exact thing 
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you're looking for (such as Smith or 100 or 6/15/96), or it can use comparison opera
tors such as > (greater than), < (less than), and so forth. Here are some rules about 
typing an expression: 

• In a number, currency, or autonumber field, don't include a currency sign or 
thousands separator. For instance, type 10000 to search for the value $10,000. 

• In a date/time field, the left-to-right order of the month, date, and year ulti
mately must match the order defined on the Date tab of the Regional Settings 
Properties dialog box in the Windows Control Panel. For instance, in the United 
States, you can enter 11/9/96 or 9 November 1996 or 9-Nov-96 or Nov 9 96, and 
Access will replace the entry automatically with #11/9/96#. 

• In a text field, you can type the text you're looking for in either uppercase or 
lowercase letters. Put quotation marks around text that includes spaces, punctua
tion, or Access operators. 

• In a memo field, you'll probably want to use the * wildcard to search for text 
embedded within the field. See "Finding Part of a Field" later in this chapter for 
examples. 

• In a Yes/No field, enter -1, Yes, True, or On for Yes; or 0, No, False, or Off for No. 
• Operators are optional. If you omit the operator, Access assumes you mean 

equals(=). 

Using Operators and Wildcard Characters 
When typing expressions in the QBE grid or the Filter By Form datasheet or form, you 
can use the operators and wildcards listed in Table 9.3 and the mathematical operators 
shown in Table 9.4. 

TABLE 9.3: OPERATORS AND WILDCARD CHARACTERS 

OPERATOR 
OPERATOR 
MEANING EXAMPLE 

EXAMPLE 
MEANING 

Comparison Operators 

> 

< 

Equals 

Greater than 

Less than 

=smith or ="smith" 

>5000 

<1 11/97 or <#1 11 /97# 

Equals smith 

Greater than 5,000 

Less (earlier) than 
january 7, 7 997 

Continued I~ 
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I TABLE 9.3: OPERATORS AND WILDCARD CHARACTERS (CONTINUED) 

OPERATOR EXAMPlE 
OPERATOR MEANING EXAMPlE MEANING 

>= Greater than or >=M or >="M" Greater than or equal 
equal to to the letter M 

<= Less than or <= 12/31/96 or <=#12/31 /96# Less (earlier) than or 
equal to equal to 

December 31, 1996 

<> Not equal to <>CA or <>"CA" Does not equal CA 

Between Between two Between 15 and 25 A number from 15 
values to 25 
(inclusive) 

In Within a set or ln(NY, AZ, NJ) or In(" NY", New York, Arizona, 
list of values "AZ" I "NJ") or New jersey 

Is Null Field is empty Is Null Records that have no 

value in this field 

Is Not Null Field is not Is Not Null Records that do have 
empty a value in this field 

Like Matches a Like MO-* or Like "MO-*" Records that start 
pattern with MO- followed 

by any other charac-
ters (see Wildcard 
Characters in this 
table) 

Logical Operators 

And Both are true >=1 And <=10 Between 1 and 1 0 

Or One or the UT or AZ or "UT" or "AZ" Either Utah 
other is true or Arizona 

Not Not true Not Like MO-??? Records that don't 
or Not Like "MO-???" start with Mo- fol-

lowed by exactly 
three characters. 

Continued I ~ 
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TABLE 9.3: OPERATORS AND WilDCARD CHARACTERS (CONTINUED) 

OPERATOR EXAMPLE 
OPERATOR MEANING EXAMPLE MEANING 

Wildcard Characters 

? Any single P?-1 00 or "P?-1 00" Values that start with 
character P followed by any 

single character, fol-
lowed by -7 00 

* Any characters (619)* or "(619)*" Any text that starts 
with (6 7 9) e.g., 
phone or fax 
numbers 

[field name] Some otherfield <[UnitPrice] Records where this 

+ 

* 

I 
\ 

in the QBE grid 

TABLE 9.4: MATHEMATICAL OPERATORS 

OPERATOR 

field's value is less 
than the value in the 
UnitPrice field 

MEANING 

Addition 

Subtraction 

Multiplication 

Division 

Integer division 

Exponent 

Mod 

& 

Remainder of division (modulo) 

join two text strings 

You also can use the Date() function to search for records by date relative to the cur

rent date. Table 9.5 shows some examples. Another function, DateAdd( ), is handy for 

specifying a range of dates based on some interval other than days . 
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I TABLE 9.5: SAMPLE DATE() AND DATEADD() FUNCTIONS 

Date() 

<=Date() 

>=Date() 

<=Date( )-30 

EXAMPlE 

Between Date() And Date( )-30 

Between Date( ) And Date( )+ 30 

Between Date( )-60 And Date( )-30 

>DateAdd("m", 1 ,Date()) 

Between DateAdd ("m",-2,Date( )) 
And Date() 

Between DateAdd("m",2,Date( )) 
And Date() 

<DateAdd('yyyy" ,-1 ,Date()) 

EXAMPlE MATCHES 

The current date 

The current date and all dates before 

The current date and all dates after 

Dates earlier than or equal to 30 days ago 

Dates within the last 30 days 

Dates within the next 30 days 

Dates between 30 and 60 days ago 

Dates that are greater than 1 month ("m") 
from the current date 

Dates between two months ago and the 
current date 

Dates between the current date and two 
months from now 

Dates that are earlier than 1 year 
("yyyy") ago 

For more information on functions and how to use them, go to the Access Help 
Index, look up References, Functions or search for the function you're interested in. 

Specifying "And/Or" Criteria 

• 

Sometimes you'll want to show only those records that meet all of your criteria. For 
instance, to locate records in the Customers table for Wilbur Stumingi in San Diego, 
structure your criteria to match only records that have Wilbur in the ContactFirstName 

field and Stumingi in the ContactLastName field, and San Diego in the City field. 
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At other times you'll want to show records that match any o(the search criteria. For 
example, you might want to show products that have a unit price of $4.95 or $12.95. 

Table 9.6 summarizes the techniques you use in the QBE grid to specify" And" and 
"Or" relationships among criteria. 

TABLE 9.6: TECHNIQUES FOR SPECIFYING AND AND OR RELATIONSHIPS 

TO SPECIFY THIS 
RELATIONSHIP ... IN ... DO THIS ... 

AND Multiple fields Place the criteria in the same row ot 
the QBE grid. 

AND 

OR 

A single field 

Multiple fields 

Use the And operator. 

Place the criteria in separate rows 
of the QBE grid. 

OR A single field 

Arranging the QBE Grid 

Use the Or operator or use the In 
operator or stack the criteria in the 
QBE grid. 

If you're creating a really complex filter with lots of fields, you may want to rearrange 

the QBE grid. Roughly the same techniques that work for customizing the datasheet 
view also work with the QBE grid. Por example: 

• To select a QBE column, click on the column selector at the top of the column. (The 
mouse pointer changes to a heavy black J- when it's positioned on a column selector.) 

• To select multiple columns, drag the mouse pointer through several column 
selectors. Or click on the column selector for the first column you want to select 
and then Shift-click on the column selector for the last column you want. 

• To select a criteria row, click on the row selector at the left edge of the row. (The 
mouse pointer changes to a heavy black~ when it's positioned on a row selector.) 

• To select multiple criteria rows, drag the mouse though the row selectors of sev
eral rows. Or click on the row selector of the first row you want to select and then 
Shift-click on the row selector of the last row you want. 

• To delete the selected rows or columns, press the Delete key or choose Edit > 
Delete Rows or Edit> Delete Columns. 
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• To insert as many blank rows or columns as you selected, press the Insert key 
or choose Insert ~ Rows or Insert ~ Columns. 

• To move the selected rows or columns, click on the row selector (for selected 
rows) or the column selector (for selected columns) inside the selected area. Then 
drag the selected rows or columns to a new position. 

To adjust column widths in the QBE grid, drag or double-click on the right boundary 
of the column selector at the top of the column(s). 

Sample Filters 
The various operators, functions, and And/Or logic in Access allow you to create a practi
cally endless variety of filters. Following are some examples of filters that are meaningful in 
the context of our sample database; they should give you some food for thought (and use
ful guidelines) for creating your own filters. 

Finding Part of a Field 
Wildcards are useful for finding information that's embedded within a field. The 
filter below will isolate records for customers on the street named Polk in the city of 
San Francisco. 

f 10lct 8 illin<l".ddress Cit 
S<~~r I I 

Cri~ t-;-!J''ke'·;:;-,,p'olk"",-.. -- --+./'"''S...,------.Fra-,-IOo-iso'o·"· --+~=--:::__-::._-

Initially, we typed the criterion into the BillingAddress field as simply *polk*. Access 
added the "Like" and quotation marks automatically. 

The City criterion, San Francisco, is on the same row as the BillingAddress field 
criterion. So in order to pass through the filter, a record must have Polk somewhere 
within the BillingAddress field and also have San Francisco in the City field. 

Wildcard characters work with all data types except OLE Objects. Suppose you create a 
table of journal references, and the table structure includes a memo field named Abstract. 
To find all the records that have the phrase "vernal equinox" embedded somewhere in the 
Abstract field, set the field's filter criterion to *vernal equinox* or Like "*vernal equinox*". 
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Wildcards are handy for isolating records with dates in a specific month. This crite
rion isolates records that have dates in March, 1997, stored in the Order Date field 
(assuming the standard mm/dd/ty notation for dates in the United States): 

Finding Ranges of Values 
You can use the various comparison operators to search for ranges of data values. For 
example, the filter below isolates customers whose last names begin with the letters A 
through M and sorts the names alphabetically by last name. 

Field: Con!8olla.1Nom~ 
S01t A.oeo<ing 

Cr~eria: ~el.ween ''A" And "N ' 1 
or: 

Notice that we used Nat the high end of the range. That's because any name (or 
word) beginning with the letter m, even mzzxxyxyx, is "less than" 11. But anything that 
comes after the letter n (in the dictionary) is considered to be "greater than" n. So even 
a simple last name like 11a is excluded because na is greater than n. 

Here's a filter that isolates and sorts (by PostalCode) customers located in the postal 
code range 92000 to 99999-0000: 

Foeld: PoslalCode 
S01l: Ascending 

Criteria: .~~~en "92000" And ''9999901J l0" 
01: 
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When entering criteria, be sure to specify only characters that are actually stored 
- ....... .- in the table. For example, the input masks for fields in Wizard-generated tables 

display punctuation characters (such as hyphens in a Zip code and parentheses in 
a phone number) in a datasheet or form, but they do not store those characters 
in the table. That's why we omitted the hyphen punctuation character in the 
Criteria cell shown above. 

Here's a simple filter that isolates and sorts (by UnitPrice) records in the Products 
table that have a Unit Price value of $25.00 or less . 

Filtering Dates 

Field: UnilPrice 
Sort Ascending_ 

Cr~e1ia: < -25 
OJ: 

The filter below isolates records with dates from the first quarter of 1997 Oanuary 1 
through March 31, 1997). In this example, we didn't have to type the# symbols. Access 
adds them automatically when you type a date into the Criteria cell. 

Oetw..en Ul ll/970At1d 113/31/9711 

You can use the Date() function in a filter to stand for the current date. See Table 9.5 
earlier in this chapter. 
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Accepting Several Values from a Field 
Suppose you want to isolate customers in the states of Alaska, California, and Wyoming. In 
this case, you want to accept records that have AK orCA or WY in the StateOrProvince 
field. There are three ways to set up the filter. Here's one: 

Field: StllloOrP.o'llnce 
Sort: 

Criteria: lo. .. ~--.k.,." O"r"'ca,..,..,.,' D""r"""W>"""•'""' +~----
o<: 

This "stacked" setup works just as well: 

Field St~rProvinoe 

s~t ' --..,.-----+----c,ite•ia lliak" 
or "ca" 

And so does this version, which uses the "In" operator to list acceptable entries: 

Field: SloleOrProv111c:e 
Sort: •--,,..,..,....--...,..-,;:--I----- 

Criteria: 'Tn l"ak"."l'<l".' ''/il•'1 
or: 

No particular method is better than another. So use whichever method seems most 
natural or convenient. Remember, too, that Access isn't picky about uppercase and 
lowercase letters in the Criteria cells; therefore, it's fine to enter the abbreviation for 
Alaska as AK or Ak or ak, or even aK. 

Saving a Filter as a Query 

Earlier in this chapter we showed you how to save a filter with the datasheet or form. 
Filters saved with the datasheet or form are available anytime you open the datasheet 
or form and apply the filter and anytime you display a filtered datasheet or form and 
then create a new form or report from the filtered records. 
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You also can save a filter as a separate query object, which will be available anytime 
you need it. Here's how: 

1. Return to the Advanced Filter/Sort filter design window. If you're viewing the 
datasheet or a form, choose Records )o- Filter ,.. Advanced Filter/Sort. If you're in 
the Filter By Form window, choose Filter )o- Advanced Filter/Sort. 

2. Click on the Save toolbar button or choose File )o- Save As Query or right-click in 
the upper pane of the window and choose Save As Query. 

3. Type a name for the query and click on OK. As usual in Access, the name can be up 
to 64 characters, including blank spaces (see the sidebar titled "Object Naming 
Rules" in Chapter 6). Access will save the filter as a query. 

When you want to reuse the query in the future: 

1. Open the table to which you want to apply the filter. This must be the same table 
you used to create the filter originally. 

2. Return to the filter window (see step 1 of the procedure for saving a filter as a query, 
just above) . 

3. Choose File )o- Load From Query, or right-click in the upper pane of the window 
and choose Load From Query. 

4. Double-click on the name of the filter you saved earlier. The filter will appear in the 
filter window. (The filter might look slightly different from the one you saved ear
lier, but it will work the same way.) 

5. Click on the Apply Filter toolbar button. 

Troubleshooting Filters 
Remember these points if your filtered results seem to have gone awry: 

• If an Access operator (such as the word "And") happens to occur within text that 
you're searching for (such as the company name Dewey Cheathem And Howe), 

place the entire text in quotation marks: 

"Dewey Cheathem And Howe" 

Otherwise, Access will misinterpret your text as 

"Dewey Cheathem" And "Howe" 

• If you're searching for text that contains punctuation marks (that is, anything 
other than numbers or letters), put quotation marks around the text. You can use 
single quotation marks(") or double quotation marks(""). 
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• Avoid confusing "And" and "Or" logic. This logic doesn't always work the way 
you'd think of it in English. For instance, to find customers in Mississippi and 
Washington, you must use an "Or" criterion, such as "MS" Or "WA". If you use an 
"And" criterion instead, Access never finds a match. That's because Access can't 
answer Yes when it asks the question "Does this record have MS in the StateOrProv
ince field and WAin the StateOrProvince field?" 

• Remember that each Criteria row in the filter asks an entirely separate and inde
pendent question. If Access can answer Yes to any one of those questions, the 
record passes through the filter. 

This last point is an important one and the cause of much confusion among neo
phyte database users. For example, look at this filter and see if you can figure out which 
Order Detail records will get through it. 

Field: Pro<hJCtiO lluantilv 
Sotl: l 

Criteria: 1-::g:------+.1 5~-----t----
~: ' 3 

At first you might say "It'll show all the orders for tether balls (ProductiD 9) in which 
the Quantity ordered is 5 or 3." But that's not exactly correct. The filter will show all the 
tether balls in which the quantity ordered is 5 and all products (regardless of ProductiD) 
for which the quantity ordered is 3. Why? Because two separate questions are being 
asked of each record: 

Question 1: Does this record have 9 in the ProductiD field and 5 in the 
Quantity field? 
Question 2: Does this record have 3 in the Quantity field? 

Any record that can pass either question comes through the filter. The second ques
tion above places no filter criterion on the ProductiD field. 

If you want to select all the tether ball orders that have a quantity ordered of 5 AND 
all the tether ball orders that have a quantity ordered of 3, you must set up two com
plete questions, like this: 

Field: I ProductiO I Q ul!flt~y 
Sort: . . 

Cr~eria: t-,;S,----- -.I.;S,...-----+----

or: 9 3 
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This second filter asks these two questions: 

Question 1: Does this record have 9 in the ProductiD field and 5 in the 
Quantity field? 
Question 2: Does this record have 9 in the ProductiD field and 3 in the 
Quantity field? 

Only records that have the 9/5 combination or the 9/3 combination will pass 
through the filter. 

As with most things in Access, you can get help as you create your own advanced filters. 
Go to the Access Help Index, search for Filters, and explore any topics of interest. As you 
scroll through the Filters topics, you'll discover a Troubles1Jooting Problems subtopic that can 
help you diagnose and solve problems with filters. 

Ouick Prints 

• 

If you're looking at a datasheet or form on the screen and need a printed copy of that 
object, you can click on the Print toolbar button (shown at left) to print the data with
out being prompted for further information. Of course, Access also gives you fancier 
ways to print things, as the next few sections will explain. 

Previewing Your Printout 
To get a sneak preview of how the data on the screen will look when printed: 

1. Start from datasheet view or form view, then 
2. Click on the Print Preview toolbar button (at left) or choose File >- Print Preview. 

A full-page image of the datasheet or form will appear. 
3. Do any of the following: 

• To zoom into or out of a portion of the image, click on the Zoom toolbar 
button or click on the image itself. Figure 9.10 shows our sample Products table 
after zooming in on the data. 

• To zoom so that you can see two pages at a time, click on the Two Pages tool
bar button. To return to one-page view, click on the One Page toolbar button, or 
click on the Multiple Pages toolbar button and click on lxl. 

• To zoom so that you can see from 1 to 6 pages at a time, click on the Multi
ple Pages toolbar button and click on your choice (lxl, lx2, etc.). 



1il3Q;l'f)l•l 
The Print Pre
view window 

for our sample 
Products table, 
after zooming 

in on the data. 

QUICK PRINTS 

• 

Products 

Product 10 Product Name nit Price 
1 Basketball $4 .95 

$5_65 
$12 95 
$325 
$6.75 

• To zoom to any magnification between 10 and 200 percent or best fit , click 
on the drop-down arrow next to the Zoom Control box on the toolbar and 
then choose a magnification. 

• To out1'ut tbc data to another Microsoft program, click n the drop-down 
a a: w ne.\.1 to the Offi eLinks toolbar butt n, and th n h s MePe It with MS 

Word, Publish It With MS Word, or Analyze It With MS Excel. ee Chapter 7.) 
• To select option· from a convenient shortcut m enu, righ t-eli k anywhere in 

the imag and choose an option from the menu, shown below. Zoom offers the 
same magnification options shown in the Zoom Control box, One Page shows 
one page a a tim ·, Multiple l ages displays up to 6 "thumbnail" pages at a 
glan e, Pa'{e etup opens a dialog box wJ1ere you can set margins and orjenta
tion I' r printing, I ri11f op•ns the Print dialog box, Save As/BxpOtt exports data 
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to another format (see Chapter 7), and Send sends the data as an e-mail mes
sage (see Chapter 7). 

4~ MICJosolt Access .. r:J 

• To immediately print whatever is in the print preview window, click on the 
Print toolbar button. Or choose File Print (or press Ctrl+P) and continue with 
step 3 of the procedure given in the next section. 

• To return to datasheet view or form view without printing, click on the 
Close toolbar button. 

Printing Your Form or Datasheet 
To print the current form view or datasheet view data without previewing it first : 

1. Select the record(s) you want to print if you want to print selected records. 
2. Click on the Print toolbar button (shown at left) if you want to use the default 

printing options and print immediately. 

Or 

If you want more control over printing, choose File > Print or press Ctrl+P. You'll 
see the Print dialog box shown in Figure 9 .11. 
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The Print 

dialog box. 
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Choose a printer. 

Prinler 

!:!a me: 

Slalus: Dei.:wlt printer: Ready 

I Type: HP LaserJet Ill 

Where LPT1 : 

Choose other printing 
options as needed. 

Commenl.: I Prir.t to fi]e 

· Print Range-

"611 [13 
r Pag•O.I [rom: I --!'-+-'Change various 

printer options. 

Print the report. Change report margins 
and turn headings off or on. 

• 

3. Choose options in the Print dialog box as needed (more on these options in a 
moment). 

4. Click on OK when you're ready to start printing. 

Most of the printing options are quite straightforward, but if you need more help, 
see "Changing the Page Setup" and "Changing Printer Properties" below, or click on 
the? button in the upper-right comer of the dialog box and then click on the option 

you're curious about. You also can explore topics in the Access Help Index that start 
with the word Pri11ting. 

Changing the Page Setup 
The Setup button in the Print dialog box takes you to the Page Setup dialog box (see 

Figure 9. 12). From there you can choose margin settings for your printed output and 
choose whether to print headings or whether to print the data only-without borders, 

gridlines, or layout graphics. 

The options available depend on the type of object you're printing . For example, 
.....,. ____ ..... Figure 9.12 shows the Page Setup dialog box for a table that we opened in datasheet 

view. The Page Setup dialog box for a form or report also includes a Layout tab; the 
Print Data Only checkbox replaces the Print Headings checkbox on the Margins tab 
(see Figure 9.12). 
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li@Q;lUfM 
The Page Setup 

dialog box 
appears when 

you click on 
the Setup but

ton in the Print 
dialog box. A 

more powerful 
Page Setup dia

log box opens 
when you 

choose File >
Page Setup 

from the 
menu bar. 

.. 
Page Setup HEi 

OK Concel 

You can reach a more powerful Page Setup dialog box than the one shown in Fig
ure 9.12 by choosing File >- Page Setup from the menu bar. When you use the menu bar 
options, you can change the page margin and header settings (from the Margins tab) and 
you can change various printer settings and properties (from the Page tab). If you're print
ing a form or report, you'll also find a Columns tab, which lets you control such things as 
the distance between rows of data on a report. 

Changing Printer Properties 
If you want to change the properties for the currently selected printer, click on the 
Properties button in the Print dialog box. Or if you choose File >- Page Setup, click on 
the Page tab, click the Use Specific Printer option, click on the Printer button, select a 
printer (if necessary), and then click on the Properties button. 

Figure 9.13 shows the Paper tab of the Properties dialog box for an HP Laser]et III 
printer. Other types of printers will have different tabs and property settings . 

.,...._ 
For even more control over your printer's properties, click on the Start button on the 
Windows Taskbar and choose Settings>- Printers (or use any equivalent techniques 
for opening the Printers window). Then right-click on the printer you want to cus
tomize and choose Properties. Changes that you make by starting from the Printers 
window affect printer properties for all Windows programs, not just Access. 
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The Properties 
dialog box for 

an HP Laserjet 
Ill printer. 

BP LaserJet Ill on LPT1 : Properties HEJ 

Paper J Graphics I Fonts I Device Options I 
Paper si1e: Letter 8 1/2 x 11 in 

D 0 
E <ecutive A4 

I 

Paper ~OUice: I UPJ>."' bay 

AJiout 

ItO 
B 

Restore Qelaults I 

OK Cancel 
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• 

You use the Properties dialog box for a printer the same way you use properties dialog 
boxes for other objects in Windows: 

1. Click on the tab for the property you want to change. 
2. Set any options you want on the selected tab . If you're unsure about what to do, 

click on the ? button in the upper-right corner of the Properties dialog box, and 
then click on the option or button you need help with . 

3. Repeat steps 1 and 2 as needed. 

4. Click on any of the buttons described below: 

• To display copyright information and the printer driver version number, 
click on th e About button in the Paper tab. Click on OK to close th e About 
dialog box. 

• To restore the settings to their factory defaults, click on the Restore Defaults 
button in any tab that offers it. 

• To apply the settings you've chosen so far, click on Apply. 

5. Click on OK when you're done choosing printer Properties. 
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Making Your Print 
Settings Stick 

At first glance, it's downright tricky trying 
to figure out which print settings will stick 
each time you print and which won't. 
These tips can help you: 

• Changes made in the Print dialog 
box are always temporary; the next 
time you open the Print dialog box 
(File >- Print or Ctri+P) the default 
settings reappear. 

• Changes made from the Page Setup 
dialog box or printer Properties dialog 

Printing Tips 

box are stored with each form and 
report and will take effect anytime you 
open the form or report and print. 
(This is true whether you get to those 
dialog boxes from the Print dialog box 
or the File >- Page Setup menu 
options.) 

• Print settings are always returned to 
the defaults after you print and close 
a table, query, or module. That is, 
changes you make in the Print, Page 
Setup, or printer Properties dialog 
boxes are discarded after you print 
and close the table or query. 

... 

Here are some tips that should come in handy whenever you're printing from data sheet 
or form view: 

• If you customize datasheet view before printing, your printout will show the cus
tom datasheet. 

• The Print Preview window will reflect any changes that you make via the Page 
Setup dialog box (File>- Page Setup). 

• If you've created a shortcut to an Access object on the Windows desktop or in a 
folder, you can quickly preview, print, or send the object via e-mail. First locate 
the shortcut and then right-click on it. Then choose Preview, Print, or Send To>
Mail Recipient from the shortcut menu. 

• In Windows 95, you can print by dragging the shortcut icon for your Access object 
to a printer icon . To locate your printer icons, open My Computer and double-click 
on the Printers folder; or click on the Start button on the Windows Taskbar, and 
choose Settings >- Printers. Or open Control Panel (Start >- Settings >- Control 
Panel) and double-click on the Printers folder. 

See Chapter 1 for information about creating shortcuts from Access objects. 



What's New in the 
Access Zoo? 
The folks at Microsoft added some new 
features to Access for Windows 97 for 
viewing data. These include 

• Filter by Input, which lets you filter 
records from a field's shortcut menu; 

Where to Go from Here 
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you can use comparison operators, 
wildcards, or functions in the filter 
expressions. 

• More powerful Print Preview with 
new options for previewing multiple 
thumbnail pages and zooming. 

This chapter has presented a potpourri of procedures for sorting, searching, filtering, 
and printing data in datasheet view and form view. The next step is to Jearn about que
ries, which Jet you ask questions about data and change data automatically. If you feel 
comfortable using the Advanced Filter/Sort features described in this chapter, queries 
will seem easy. 
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